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About myself (in short)

e | owell Montgomery (LoMo on Drupal.org)

e ive in Frankfurt, Germany
(Born in UK and “from” northern California)

e First Drupal website: http://FrankfurtNavigator.com
(site-builder / themer / author)

e Cocomore: 1) Internee; 2) developer trainee;
now freelancer

e Author / Content creator: Cocomore Drupal Blog
http://drupal.cocomore.com/blog
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Sut what about Eclipse???
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Benefits of using Eclipse

e Free / Open-source

e Multi-Platform (Java-based)

e Powerful debugging features

e Syntax highlighting and error flagging
e | ots of plugins to extend features

e Drupal templates available
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Drawbacks of using Eclipse

e Resource hog
¢ Java-based, not native app

e Some pricey IDEs may be better, especially if you
already use them
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L HON&) Eclipse Downloads

4| » |[|cA] | + |[BEnhttp://www.eclipse.org/downloads/ ¢ ._ Google

LAS T W E E K F o R E A R LY Visit other Eclipse Sites
eCI.Il'seCON

2B REGISTRATION ™ g Q

Home Downloads Users Members Committers Resources Projects About Us 008

Eclipse Downloads

Packages Developer Builds Projects

Compare Packages Older Versions Eclipse Indigo (3.7.1) Packages fi v pac 0S X (Cocoa)

Windows
Linux

Eclipse IDE for Java Developers, 127 MB Mac OS X 32 Bit
Downloaded 3,393,426 Times Details Mac OS X 64 Bit

=== Eclipse IDE for Java EE Developers, 210 MB Mac OS X 32 Bit
goad Downloaded 2,411,123 Times  Details Mac OS X 64 Bit
> Eclipse Classic 3.7.1, 173 MB Mac OS X 32 Bit
Downloaded 1,241,158 Times Details Other Downloads Mac OS X 64 Bit

http://www.eclipse.org/downloads/
Get latest version of Eclipse Classic for your OS

Note: PDT bundles are not up-to-date

1l¢™ Custom Se
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You\
envir
SES
dowr
and ¢
Softv
other
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OO Downloads )
<) (=Bla]m] (&) (8] a |

Back View Action Dropbox Search

Name

> @ eclipse

E] eclipse-SDK-3.7.1-macosx-cocoa-x86_64.tar.gz

On Mac:
1. Extract Ecllpse tarball
2. Drag “eclipse” to Applications
& Downloads . 3. (optional) Drag eclipse
G A application to Dock for
(,m“ easy launch.

v | = — B R
1 of 2 selected, 60.82 GB available Y

Installing on Linux or Windows should be easy, too.
Note: You do need a JVM (Java Virtual Machine)
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Eclipse/installation hitp. //wiki.eclipse.org/Eclipse/Installation

< Eclipse

Installing Eclipse is relatively easy, but does involve a few steps and software from at least two different sources. Eclipse is a Java-based
application and, as such, requires a Java runtime environment (JRE) in order to run.

Contents [hide]

1 Install a JVM
1.1 JRE/JDK Sources

2 Eclipse 3.7.1 (Indigo)
3 Extending Eclipse
4 More information

Install a JVM [edit]

Regardless of your operating system, you will need to install some Java virtual machine (JVM). You may either install a Java Runtime
Environment (JRE), or a Java Development Kit (JDK), depending on what you want to do with Eclipse. If you intend to use Eclipse for Java
development, then you should install a JDK (the JDK includes--among other useful things--the source code for the standard Java libraries). If

you aren't planning to use Eclipse for Java development and want to save some disk space, install a JRE.

« If you're using Windows, you may already have a JRE installed, but upgrading won't hurt.
« Ifusing Linux, read this

« GCJ will NOT work.
« Also see: Installing JRE 1.6.0 (Update x) as the Default Runtime in Linux &.

JRE/JDK Sources [edit]

There are several sources for a JRE/JDK. Here are some of the more common/popular ones (listed alphabetically):

- BMJDKE Modern OS X has a suitable JRE by default.
« OpenJDK &

.oracie Joke LINUX USErs may want Oracle JDK (iatest Aptana Studio)
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ipse

INDIGO

is a trademark of the Eclipse Foundation,Inc, Oracle and Java are registered trademarks
of Oracle andfor itsaffiliates, Othernames may be trademarks of theirrespective owners,

800 Workspace Launcher

Select a workspace

Eclipse SDK stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace:  [Users/lowell/Documents /workspace 3 ( Browse... ::

@ Use this as the default and do not ask again

, h
( Cancel ( OK )

Select a suitable “workspace” for Eclipse to store your
project(s). Note: You can have multiple workspaces.
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Eclipse File Edit Navigate Search Project Run Window Help 9

Workbench

Welcome to Eclipse /

Go to Workbench view
Overview

Get an overview of the features

Tutorials
Go through tutorials

B

@<, Samples <> What's New

T~ Try out the samples Find out what is new
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Install the

DT (P

P Developer Toolkit)




Search Project Run Window REs

[F'aRaSE v S s Welcome |

(?) Help Contents
@7 Search
Dynamic Help

Key Assist...
Tips and Tricks...
Cheat Sheets...

Check for Updates

Install New Software...

Help > Install New Software...
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Available Software
Check the items that you wish to install.

Work with; Tlndigo - http://download.eclipse.org/releases/indigo 8 ( Add.. )
Find more software by working with the "Available Software Sites” preferences.

‘rlypr filter text B
Name Version

() » 000 Modeling }
() w000 Programming Languages

) @Autotools support for COT (Incubation) 3.0.1.201108301805

O @ C/C++ Call Graph Visualization (Incubation) 0.0.2.201108301805

0 4 C/C++ Development Tools 8.0.0.201109151620

O Cfa C/C++ Development Tools SOK 8.0.0.201109151620

(] @C/Co + Library APl Documentation Hover Help (Incubation) 0.3.0.201108301805

0 g5 COT Visual C++ Support 1.0.0.201109151620

@) '&’;Dynamlc Languages Toolkit - iTcl Development Tools 3.0.0.v20110424-79--90A5876C8I14898

O @Dynamic Languages Toolkit - Ruby Development Tools 3.0.0.v20110424-7Z--E_EKMYXO04k101442

0 Q&Dynamic Languages Toolkit - TCL Development Tools 3.0.0v20101109-0623-7g--EC3WSgpTP. ..

= @Dynamic Languages Toolkit - XOTc| Development Tools 3.0.0.v20110424-78~-~_kE7A_BKDJO1155

O @Eclipse Java Development Tools 3.7.1.r371_v20110810-0800-7z8gFcof...

O g Eclipse XML Editors and Tools 3.3.1.v201108102009-7H7EFZ3DxumTla...

0 ff» Fortran Development Tools (Photran) 7.0.2.201109141657

O @lm XLF Compiler Support 7.0.2.201109141657

0 §*Javascript Development Tools 1.3.1.v201108102009-7F78FXRFBBOPDX. .

(] % Linux Intel(R) Fortran Compiler Support 7.0.2.201109141657

O QEObject Teams Development Tooling 2.0.1.201109101025

= !-f» Object Teams Equinox Integration 2.0.1.201109101025 \:
- 'HP Development Tools (PDT) SDK Feature 3 Ov20110516-1100-77--84 23)BVQS -

( Select Al ) ( Deselect All )

Details
8 Show only the latest versions of available software () Hide items that are already installed
™ Group items by category Wwhat is already installed?

() Show only software applicable to target environment
™ Contact all update sites during install to find required software

@ ( < Back )k Next > ] ( Cancel ) (" Finish /‘
A

Note: Default PDT is Not up-to-date
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A6 Install

Available Software l
Select a site or enter the location of a site. \@é
Work with: | type or select a site L] ( Add... )

Find more software by working with the "Available SoftwargSiteés” preferences.

~

type filter text i
pe filter tex Click Add...

‘Name Version
() (@ There is no site selected.

Name: PDT ( Local... )

Location: | http://download.eclipse.org/tools/pdt/updates/3.0/mi ( Archive... )

ol -

C — http:/download.eclipse.org/tools/pdt/updates/3.0/milestones/ =i

( selectAll ) @ ( Cancel ) oI

_ Details
@ Show only the latest versions of available software [ Hide items that are already installed
@ Group items by category What is already installed?

() Show only software applicable to target environment

Q] Contact all update sites during install to find required software

Instead, you may want to use the milestones repository...
@ ( <Back ) ( Next> ) ( cancel ) ( Finish

Vi

http://download.eclipse.org/tools/pdt/updates/3.0/milestones/
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b £,

Work with: [PDT-http://download.eclipse.org/tools/pdt/updates/3.0/mi|estones/ B ( Add... )

Find more software by working with the "Available Software Sites" preferences.

( type filter text R
Name Version
(=] w00pdt3.1.0 M201201110400
= r?-fﬂ:PDT Mylyn Feature 3.0.15v201201110400-4-07w31231222151
g @PHP Development Tools (PDT) All-In-One SDK 3.0.0.v201201110400-77-07E92C5Ad7...
O r?-f)i:PHP Development Tools (PDT) Runtime Feature 3.0.1.v201201110400-7V-79F8NcJT¢JTT..
O '3::!: PHP Development Tools (PDT) SDK Feature 3.0.0.v201201110400-77-184_2BEICRg...
O 'Efﬂ: PHP Development Tools (PDT) Source Feature 3.0.1.v201201110400-7V-79F8NcJTJTT..

IREES
(" selectAll ) ( DeselectAll ) 1 item selected
| D&tails 1
8 Show only the latest versions of available software () Hide items that are already installed
8 Croup items by category What is already installed?
(") Show only software applicable to target environment
8 Contact all update sites during install to find required software

You could just get the “PDT Runtime Feature”
@ (< Back :: ( Next> ) ( Cancel ) ( Finish
Vi
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Install Details

Review the items to be installed.

Name Version L
V@: PHP Development Tools (PDT) All-In-One SDK 3.0.0.v201201110... org.eclipse.php.all.feature.group
v @:PDT Mylyn Feature 3.0.1.v201201110... org.eclipse.php.mylyn.feature.group
v @: Dynamic Languages Toolkit - Mylyn Integration 3.0.0.v20101025-... org.eclipse.ditk.mylyn.feature.group
> @:Dynamic Languages Toolkit - Core Frameworks 3.0.0.v20101211-... org.eclipse.dltk.core.feature.group
@:Mylyn Task List 3.6.2.v20110908-... org.eclipse.mylyn_feature.feature.group
@:Mylyn Task-Focused Interface 3.6.2.v20110908-... org.eclipse.mylyn.context_feature.featur¢
v @: PHP Development Tools (PDT) SDK Feature 3.0.0.v201201110... org.eclipse.php.sdk.feature.group
v @: PHP Development Tools (PDT) Runtime Feature 3.0.1.v201201110... org.eclipse.php.feature.group

v @Dynamic Languages Toolkit - Core Frameworks 3.0.0.v20101211-... org.eclipse.dltk.core.feature.group
@: EMF - Eclipse Modeling Framework Core Runtime 2.7.1.v20110912-... org.eclipse.emf.ecore.feature.group
@Dynamic Languages Toolkit - Core H2 Index Fra... 3.0.0.v20101026-... org.eclipse.ditk.core.index.feature.group
@: PHP Development Tools (PDT) Source Feature 3.0.1.v201201110... org.eclipse.php.source.feature.group

Size: 48,544 KB

Details

@ ( <Back ) foNexts>9) ( cCancel ) ( Finish )
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Review Licenses

Licenses must be reviewed before the software can be installed. This includes licenses for software required to
complete the install.

Licenses: License text:

Eclipse Foundation Software User Agreement  Eclipse Foundation Software User Agreement
EMF - Eclipse Modeling Framework Core Runtime 2.7.1.v201109] February 1, 2011
Mylyn Task List 3.6.2.v20110908-0706
Mylyn Task-Focused Interface 3.6.2.v20110908-0706 Usage Of Content

VEclipse Foundation Software User Agreement THE ECLIPSE FOUNDATION MAKES AVAILABLE
Dynamic Languages Toolkit - Core Frameworks 3.0.0.v20101211 SOFTWARE, DOCUMENTATION, INFORMATION AND/
Dynamic Languages Toolkit - Core H2 Index Frameworks 3.0.0.vi OR
Dynamic Languages Toolkit - Mylyn Integration 3.0.0.v20101025 OTHER MATERIALS FOR OPEN SOURCE PROJECTS
PDT Mylyn Feature 3.0.1.v201201110400-4-07w312312221511| (COLLECTIVELY "CONTENT").

PHP Development Tools (PDT) All-In-One SDK 3.0.0.v201201110] YSE OF THE CONTENT IS GOVERNED BY THE TERMS

. AND CONDITIONS OF THIS
PHP Development Tools (PDT) Runtime Feature 3.0.1.v20120111 AGREEMENT AND/OR THE TERMS AND CONDITIONS

PHP Development Tools (PDT) SDK Feature 3.0.0.v20120111040C ' OF LICENSE AGREEMENTS OR

PHP Development Tools (PDT) Source Feature 3.0.1.v2012011104 NOTICES INDICATED OR REFERENCED BELOW. BY
USING THE CONTENT, YOU

AGREE THAT YOUR USE OF THE CONTENT IS
COVERNED BY THIS AGREEMENT

AND/OR THE TERMS AND CONDITIONS OF ANY
APPLICABLE LICENSE AGREEMENTS

OR NOTICES INDICATED OR REFERENCED BELOW. IF
YOU DO NOT AGREE TO THE

TERMS AND CONDITIONS OF THIS AGREEMENT AND
THE TERMS AND CONDITIONS

OF ANY APPLICABLE LICENSE AGREEMENTS OR
NOTICES INDICATED OR REFERENCED

BELOW, THEN YOU MAY NOT USE THE CONTENT.

Applicable Licenses

Unless otherwise indicated, all Content made
available by the

PRI

® | accept the terms of the license agreements I

!. ———— ’ y<> () I do not accept the terms of the license agreements

@ ( <Back ) [ Next> ) ( Cancel ) | @G Finisho)

A\
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Downloading org.eclipse.wst.common.core

() Always run in background

(" cancel ) ( Details>> ) ( RuninBackground )

A

After installation comes a prompt to restart...

N You will need to restart Eclipse SDK for the installation changes to take effect. You
“.* ./ may try to apply the changes without restarting, but this may cause errors.

o

( Not Now ) ( Apply Changes Now ) ( RestartNow )
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Install other Eclipse plugins
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All Products Dreamweaver Eclipse Drupal
jQuery

Drupal for Eclipse
http://xtnd.us/eclipse/drupal

Version: 0.2.0

Check the ems that you wish 1o install

' 1
S
Work with:  XTND.US - http //xtnd . us fechipse/updates B ( Md..@

find more software by working with the ‘Available Software Sites' preferences.

'r- “ or text %

Eclipse IDE, PHP, and Drupal - that's a lethal combo! This plug-in
for Eclipse provides a layer of Drupal enhancements to PDT (PHP
Developer Toolkit) for Eclipse IDE.

Name Version

o 4+ Crupal for Eclipse POT 0.2.0.201001010204
Links: J
XTND.US Eclipse Plug-ins Install Site |
|
Installation notes e
Crupal for Eclipse 0.0.0.20100101020408
To install any of our Eclipse plug-ins choose the "Help" menu, ¥ Show only the latest versions of available software 1 Hide items that are already installed
then "Install New Software". Click the "Add" button or link and ¥ Group items by category Whatis already instafied?
add this new software site: M Contact 2l update sites during install to find required software
Name: XTND.US - - .
Location: http://xtnd.us/downloads/eclipse r -~ ——— —
System Requirements e |

Mac OS X, Windows, and Linux operating systems. Requires e
Eclipse IDE 3.4 or higher. PDT (PHP Developer Toolkit) must be
installed prior to installing this plug-in suite.
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OO0 Install

Available Software
Select a site or enter the location of a site.

Work with: ftvpe or select a site Lj Add...
Find more software by working with the “Available Software Sites” preferences.
’ _ L ' Add Repository
type filter text
Name | Name: | XTND.US| ( . ) B
) (@ There is no site select
Location: http://xtnd.us/downloads/eclipse ( Archive... )

@ ( Cancel ) (wOK—

'C N« »]
( Select Al ) ( Deselect All )
i Deuils '
@ Show only the latest versions of available software ("] Hide items that are already installed
W Group items by category What is already installed?
") Show only software applicable to target environment
Q! Contact all update sites during install to find required software
® ( <Back ) ( Next> ( Cancel ) ( Finish )
Z

Name: XTND.US
Location: http://xtnd.us.downloads/eclipse
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Available Software

Check the items that you wish to install.

Work with: [XT ND.US - http://xtnd.us/downloads/eclipse ™ ( Add.. )

Find more software by working with the “Available Software Sites" preferences.

( type filter text \
Name [Version

™ ¥ 000 Drupal for Eclipse

v (% Drupal for Eclipse PDT 0.2.1.201001011121

( selectAll ) ( Deselect All ) 1 item selected

. Details )
g Show only the latest versions of available software (] Hide items that are already installed
™ Group items by category What is already installed?

() Show only software applicable to target environment

S Contact all update sites during install to find required software

@ ( <Back ) @@wNexew ( Cancel ) ( Finish )

Vi
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' .
[ type filter text

VGeneral
» Appearance
Capabilities
Compare/Patch
Content Types
» Editors
Keys
» Network Connections
Perspectives
Search
P Security
b Startup and Shutdown
Web Browser
»Workspace
» Ant
» Dynamic Languages
» Help
»Install/Update
> Java
» JavaScript
» Mylyn
» PHP
» Plug-in Development
» Run/Debug
»Team
»Web
» XML

Content Types

See 'File Associations' for associating editors with file types.
Content types:

Java Class File
VText
Configuration Files
CsSs
rupal .Info
Drupal Translation File
HTML
» JAR Manifest File
» Java Properties File
Java Source File
JavaScript Source File
JS Object Notation File
VPHP Content Type
Drupal Module
Refactoring History File
Refactoring History Index
Runtime log files
> WikiText
» XML
XML (lliformed)

Content types added by XTND.US plugin

File associations:

*.install (locked)
*.module (locked)
*.test (locked)

( Add. )

| c—eE—
( Edit.. )

"8 P
5 Remove )

Default encoding: \

‘( Update )

@

( cancel

) Cmmpiem—
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Install other Eclipse plugins

eGit for GUI-based Git repository actions
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Available Software

Check the items that you wish to install.

Work with: Il Indigo - http://download.eclipse.org/releases/indigo B I( Add.. )

Find more software by working with the “Available Software Sites" preferences.

egit 0\
S— '
Name \Version
(=] w00 Collaboration
v ':-'--Eclipse EGit 1.1.0.201109151100-r
O 4 Eclipse EGit Mylyn GitHub Feature 1.1.0.201109151100-r
O 4+ EGit Mylyn 1.1.0.201109151100-r

)< >

( selectAll ) ( Deselect All ) 1 item selected

I Details |
g Show only the latest versions of available software () Hide items that are already installed
8 Group items by category What is already installed?

() Show only software applicable to target environment

g Contact all update sites during install to find required software

@ ( < Back )W ( cancel ) ( Finish

i’
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Click on this this icon near the top

nght —) [ &IPHP &) )ava

Y l@PHP &Jjava

&' PHP

An outline is n

Git Repository Exploring

==l /SE Outline 53 %> Debug = B

v

-%]CVS Repository Exploring

3
5= Outline 53 |Open Perspective| = |

-

An outline is not available.

ﬁ Debug

$m Git Repository Exploring
a" Java (default)

15JJava Browsing
Tg’java Type Hierarchy
@:’javaScript

& PHP

Planning

«J==Plug-in Development
Ej Resource

%SVN Repository Exploring
EYTeam Synchronizing

X XML

( Cancel ) (oK
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3 Choices:
Add existing...
Clone...
Create new...

Select one of the following to add a repository to this view:

L% Add an existing local Git repository

:,_3] Clone a Git repository

L.® Create a new local Git repository

Search and select Git repositories on your local file system

Gl

‘ i

Search criteria

Directory: | /Users/lowell/Git Checkouts/intlinks|

E Look for nested reposntones 1

PorowseB
) Look for nested.

( type filter text

8 /Users/lowell/Git Checkouts/intlinks/.git

( Cancel

) Cmmyp—

a |l
1

5
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|3~ JQr | BB ] Gy 752 Git Reposito... &

. Gt Reposiories 2 ~oyf =
BERIXAR|S B =E”
v [] Intlinks [7.x~1.2] = fUsers/lowell /Git Checkouts /intlinks/.git
v &5 Branches
¥ (= Local
89, 7.x-1.2
&3, master
¥ (= Remote Tracking
&3 origin /master
V%Tags
G97.x-1.0
G57.x-1.1

¥ (= References
%:j HEAD - refs/heads/7.x-1.2 - 16f7f1b0827d332bee92000d53fa0q
v () Remotes
v £ origin
o] LoMo@git.drupal.org:project/intlinks.git
<] LoMo@git.drupal.org:project/intlinks.git
¥ &> Working Directory - /Users/lowell/Git Checkouts/intlinks

= .buildpath (E Properties 83\5 History] SO Synchronize]d" Git Suqing} A Git Reﬂog] =0
X| project

@J:tli:lks common_functions.inc o] EJ "ﬁ'o I Raposioty Confgumion . Singe Yaue m -
8] intlinks_hide_bad_links.inc Property Value

7] intlinks_title_filter.inc
] intlinks.info
7] intlinks.module
] README.txt
> = 9it
P (3 settings

The eGit|interface

1l ma 1
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Install other Eclipse plugins

Subclipse for GUI-based SVN repository actions
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eclipse

marketplace

Home My Marketplace

Markets

Sort by

Relevancy
Title

Author
Date

Filter by Status

() Production/Stable (3)

() Beta (2)
QMature[‘l)

Filter by License Type

(JEPL(4)
()BSD (1)
CJLGPL (1)

Filter by Categories

“22"Note: You rea
But Subversive is the default SVN integration

plugin.

»

Visit other Eclipse Sites

®@ 4 QS =®

Add Content Login

1,294 Solutions and counting.

Subclipse Project All Solutions Categories

All Markets

Advanced Search v

Found 6 results matching your query.

o | Subclipse
P | An Eclipse Team Provider plug-in providing support for Subversion within the Eclipse IDE. Developed
287 10 | and maintained by Subversion core committers, Subclipse is always in synch ..

Install alm |Code Management |mylyn | Mylyn Connectors | Last Updated on 12 July 201 1Fy Mark Phippard
mysvn | mysvntool |SCM | Subclipse |subversion |svn |

Team Development |team provider | Tools | Tools | version control

- MPC Downloads
N/ op 11U

®Subversive - SVN Team Provider
The Subversive project aims to provide Subversion (SVN) integration for Eclipse. The Subversive plug-in
gives you the ability to work with this CVS successor version control ...

Code Management | Mylyn Connectors |SCM | Last Updated on 9 March 2010}:y Igor Vinnykov
subversion |svn | Team Development |team provider |

Tools |Tools
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Eclipse 3.2/Callisto, 3.3 /Europa, 3.4/Ganymede, 3.5/Galileo, 3.6 /Helios, 3.7 /Indigo, +
Subclipse 1.8.4 and 1.6.18 and 1.4.8 are now available for Eclipse 3.2+!

See the changelog for details. Existing Subclipse users should read the upgrade instructions for important
information on changes you to need to make to your Eclipse preferences to see the new version in the update
manager.

Subclipse 1.4.x includes and requires Subversion 1.5.x client features and working copy format.
Subclipse 1.6.x includes and requires Subversion 1.6.x client features and working copy format.
Subclipse 1.8.x includes and requires Subversion 1.7.x client features and working copy format.

Links for 1.8.x Release: h - / / b I' t' -

Changelog: http://subclipse.tigris.org/subclipse_1.8.x/changes.htmi| ttp- Su C Ipse- Ig rIS-Org_
Eclipse update site URL: http://subclipse.tigris.org/update_1.8.x

Zipped downloads: http://subclipse.tigris.org/serviets/ProjectDocumentList?folderiD=2240

Links for 1.6.x Release:

Changelog: http://subclipse.tigris.org/subclipse_1.6.x/changes.htmi|

Eclipse update site URL: http://subclipse.tigris.org/update_1.6.x

Zipped downloads: http://subclipse.tigris.org/serviets/ProjectDocumentList?folderiD=2240

Links for 1.4.x Release:

Changelog: http://subclipse.tigris.org/subclipse_1.4.x/changes.htmi|

Eclipse update site URL: http://subclipse.tigris.org/update_1.4.x

Zipped downloads: http://subclipse.tigris.org/serviets /ProjectDocumentList?folderiD=2240

8,00 Add Site
Name: Subclipse 1.6.x {Eclipse 3.2+) ( Local.. )
Location: | http://subclipse.tigris.org/update_1.6.x ( Archive... )

@ ( Cancel ) GGk

Name: Subclipse 1.6.x (Eclipse 3.2+)
Location: http://subclipse.tigris.org/update_1.6.x
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http://subclipse.tigris.org
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Available Software

Check the items that you wish to install.

Work with: o[Subclipse 1.6.x (Eclipse 3.2+) - http:IIsubclipse.tigris.orglupdate=l.6.x ( Add... )

Find more software by working with the "Available Software Sites" preferences.

\|

( type filter text

Name Version —
'™ ¥ 000 Core SVNKit Library |
™ (% SVNKit Library 1.3.5.7406

‘™ w000 Optional JNA Library (recommended)

4 (% NA Library 3.2.7

™ v 000 Subclipse

8 @:CollabNet Merge Client 2.2.4

8 @:Subclipse {Required) 1.6.18

™ @:Subclipse Integration for Mylyn 3.x (Optional) 3.0.0

™ (* Subversion Client Adapter (Required) 1.6.12

‘g @LSubversion JavaHL Native Library Adapter (Required) 1.6.17

™ @:Subversion Revision Graph 1.0.9

g @:SVNKit Client Adapter (Not required) 1.6.15

( selectAll ) ( DeselectAll ) 9 items selected

. Details :
g Show only the latest versions of available software (") Hide items that are already installed
™ Group items by category What is already installed?

() Show only software applicable to target environment

E Contact all update sites during install to find required software

@ (< Back )M ( Cancel ) { Finish )
Z
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Critical Stuff: Preferences

Drupal Coding Standards tweaks...
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W

type filter text

¥ General
> Appearance W
Capabilities
Compare/Patch
Content Types
¥ Editors
File Associations
¥ Structured Text Edi
Task Tags
¥ Text Editors
Accessibility
Annotations
Hyperlinking
Linked Mode
Quick Diff

Text Editors

C:lv Wt

See 'Colors and Fonts' to configure the font.

Undo history size: 200

Displayed tab width:

E Insert spaces for tabs

<—

8 Highlight current line

Show print margin

Print margin column: 80

Spelling “

Keys

» Network Connections
Perspectives
Search

» Security

b Startup and Shutdown
Web Browser

8 Show line numbers
8 Show range indicator

(] Show whitespace characters

g Show affordance in hover on how to make it sticky

Check!

n'zl_]'l — Change from

‘4’ to ‘2’

~ (Less critical, but good to help
keep manage line widths.

When mouse moved into hover: [ Enrich after delay

3

8 Enable drag and drop of text
8 Warn before editing a derived file

¥Workspace g Smart caret positioning at line start and end
Build Order
Linked 3esources Appearance color options:
Local History
» Ant Line number foreground _
i Current line highlight Color:
» Dynamic Languages urren ghlig
> Help Print margin
» Install/Update Find scope "
b Java Selection foreground color
> JavaScript Selection background color
» Mylyn A Background color
Y PHP A Foregrf)und color A
Appearance | Hyperlink A
| - J</»! M
® ( Cancel ) GO

Preferences > General > Text Editors

/4
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800 Preferences

| type filter text ' Workspace Pv v w
¥General

» Appearance W See 'Startup and Shutdown' for workspace startup and shutdown preferences.
Capabilities
Compare/Patch E Build automatically
Content Types

» Editors [ Refresh using native hooks or polling
Keys

» Network Connections 03 Refresh on access
Perspectives () Save automatically before build
Search : e

b Security (] Always close unrelated projects without prompt

b Startup and Shutdownw
Web Browser

Workspace save interval (in minutes): 5

VWorkspace
Build Order Workspace name (shown in window title):
Linked Resources
Local History ) -
> Ant Open referenced projects when a project is opened
» Dynamic Languages (O Always () Never ® Prompt
» Help
:JlnstaII/Update Text file encoding New text file line delimiter
ava
b JavaScript (O Default (MacRoman) () Default
:m:’yn © Other: | UTF-8 - @® Other: | Unix 44
Appearance

¥ Code Style
Code Templates
Formatter

¥ Debug
Installed Debugger

Step Filtering

Workbench Option:
e IMPORTANT!!!
Code Folding Change from defaults to UTF-8 encoding and Unix line delimiter.
Content Assist
Hovers

Preferences > General > Workspace
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.m%

C )

Local History -

> Ant
» Dynamic Languages
> Help
»Install/Update
> Java
> JavaScript
» Mylyn
VPHP
Appearance
¥ Code Style T
Code Templates
Formatter
¥ Debug
Installed Debugger
Step Filtering
Workbench Option:
¥ Editor
Code Folding
Content Assist
Hovers
Mark Occurrences m
Save Actions
Syntax Coloring
Task Tags
Templates
Typing
New Project Layout
Path Variables
VPHP Executables
Execution Environn
PHP Interpreter
PHP Libraries
PHP Manual
PHP Servers A
VPlug-in Development v

——

T4 »

Formatter

Formatting

Tab policy:

Indentation size:

L Spaces

+

Default indentation for wrapped lines:

Default indentation for array initializers:

2
4

4

@

Preferences > PHP > Code Style > Formatter

( Cancel ) C

OK

)

Vi
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Preferences

0o

type filter text
Local History
> Ant
» Dynamic Languages
> Help
»Install/Update
> Java
> JavaScript
» Mylyn
VPHP
Appearance
¥ Code Style
Code Templates
Formatter
¥ Debug
Installed Debugger
Step Filtering
Workbench Option:
¥ Editor
Code Folding
Content Assist
Hovers
Mark Occurrences

Save Actions

<::Jv T

8 Remove trailing whitespace

Syntax Coloring
Task Tags
Templates
Typing

New Project Layout

Path Variables

VPHP Executables

Execution Environn

PHP Interpreter

PHP Libraries

PHP Manual

PHP Servers
¥ Plug-in Development
¢— — “3 J4 >

"

>

v

@™ All lines () Ignore empty lines

Configure Project Specific Settings...

(Restore Defaults) ( Apply )

@

( Cancel ) ( OK )

Vi

Preferences > PHP > Editor > Save Actions
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_ type filter text

Syntax Coloring
Task Tags
Templates
Typing
New Project Layout
Path Variables
VPHP Executables
Execution Environn
PHP Interpreter
PHP Libraries
PHP Manual
PHP Servers
¥ Plug-in Development
API Baselines
API Errors/Warnings
APl Use Scans
Compilers
Editors
OSGi Frameworks
Target Platform
» Run/Debug
¥Team
»CVS
File Content
»Cit
Ignored Resources
Models
»SVN
¥Web
VCSS Files

L vEditor |

Content Assist
Syntax Coloring

Editor

<;:Jv e

Templates
»HTML Files
» XML
¢ — <>

CSS editing preferences. Note that some preferences may be set on the Structured Text

Editors preference page.

Formatting

Line width: 72
8 Insert line break between properties

8 Disable wrapping in style attribute of HTML

() Indent using tabs

6 Indent using spaces

Indentation size: 2

8

' Capitalization style

Identifier:

Type selector:

Property name: Property value:

® Uppercase

() Lowercase

() Uppercase

® Lowercase

() Uppercase

® Lowercase

() Uppercase

® Lowercase

(Restore Defaults) ( Apply )

@

( Cancel ) —o—9

.

Preferences > Web > CSS Files > Editor
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. type filter text ' Editor =1 v w
VPHP Executables ~
Execution Environn HTML editing preferences. Note that some preferences may be set on the Structured Text m
PHP Interpreter Editors preference page.
PHP Libraries
PHP Manual Formatting
PHP Servers
¥Plug-in Development Line width: 72

APl Baselines

AP Errors/Warnings () Split multiple attributes each on a new line

APl Use Scans (] Align final bracket in multi-line element tags
Compilers :
Editors () Clear all blank lines
OSGi Frameworks () Indent using tabs
Target Platform ' ® ind .
» Run/Debug Indent using spaces
¥ Team Indentation size: 2 @
»CVS ,
File Content Inline Elements:
»Git a
Add...
Ignored Resources abbr m ( i )
Models acronym
» SUN w b ( Remove )
¥Web basefont
VCSS Files big
¥ Editor br
Content Assist cite ~—
Syntax Coloring em 4
Templates font Y
VHTML Files
* Preferred markup case for content assist, and code generation
Content Assist Tag names: Attribute names: &
Syntax Coloring | )
Tempkates () Uppercase () Uppercase
Typing u ® Lowercase ® Lowercase
Validation A »
» XML _ v :
¢— - <> 1
® ( Cancel ) G—H .
V.

Preferences > Web > HTML Files > Editor
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9.0 ) Preferences

[ type filter text s Editor =X vy w
PHP Manual -
PHP Servers XML editing preferences. Note that some preferences may be set on the Structured Text
API Baselines
API Errors /Warnings Formatting
APl Use Scans —
Compilers Line width: 72
Editors : . : .
O |
OSGi Frameworks |_J Split multiple attributes each on a new line
Target Platform (] Align final bracket in multi-line element tags
» Run/Debug 2 ; -
¥Team (] Preserve whitespace in tags with PCDATA content
»CVS (] Clear all blank lines
File Content
b Git 8 Format comments
Ignored Resources ™ Join lines
Models
» SVN 8 Insert whitespace before closing empty end-tags
¥Web () Indent using tabs
WSS Files
v Editor {® Indent using spaces

Content Assist g
Syntax Coloring

Indentation size: 2 @

Tgmplates Grammar Constraints
VHTML Files
Y Editor @ Use inferred grammar in absence of DTD/Schema

Content Assist
Syntax Coloring
Templates
Typing
Validation
XML
XML Catalog
¥ XML Files &

____ PEditor [

Validation b ( Restore Defaults ) (  Apply )
¢ _— ) <>

@ ( Cancel ) ( OK )

7~

Preferences > XML > XML Files > Editor
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Helpful Stuff: Preferences

Import Templates for Drupal hooks
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Download & Extend

Download & Extend Home Drupal Core | Modules | Themes Translations Installation Profiles
. http://drupal.org/project/eclipse
Eclipse IDE purartipal.orgerol P
U  Version control Revisions
M
Posted by deekayen on December 16, 2010 at 2:56pm e
Templates for Drupal hooks in Eclipse PDT. = last
S Vie
Related helpful tools: ?E: Vie
e Drupal plug-in for Eclipse PDT e
Project Information = Is!
Maintenance status: Seeking co-maintainer(s) ::*: TO_
Development status: Maintenance fixes only 2= sut
Module categories: Developer ’
Last modified: October 25, 2011 Ad
All
Downloads 2 0
Version Downloads Date Links Bu
7.x-1.1 tar.gz (17.53 KB) | zip (18.04 KB) 2011-Dec-07 Notes lo
6.x-1.0 tar.gz (12.05 KB) | zip (12.53 KB) 2010-Dec-16 Notes Sut
Issi
View all releases Olc
. Re
You can install both Drupal 6 and Drupal 7 core hooks. ie

Note: This is NOT a module & both download as a folder called “eclipse”. Rename, if you like.

http://drupal.org/project/eclipse
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http://drupal.org/project/eclipse
http://drupal.org/project/eclipse

" "
type flter text

> General
> Ant
» Dynamic Languages
> Help
»Install/Update
> Java
¥ JavaScript
» Mylyn
VPHP
Appearance
P Code Style
» Debug
¥ Editor
Code Folding
Content Assist
Hovers
Mark Occurrences
Save Actions
Syntax Coloring
Task Tags
Templates
Typing
New Project Layout
Path Variables
VPHP Executables
Execution Environmer
PHP Interpreter
PHP Libraries
PHP Manual
PHP Servers
» Plug-in Development
» Run/Debug
b Team
»Web
XML

3 <« »

Templates SOv v w
Create, edit or remove templates:
Name Context Description Auto lnso__ ( New... )
M eco php echo a string ~
™ elif php elseif statement { Edit... p
™ els php else statement -
™ fnc php function statement ,
™ for php for statement \ RIS
™ fore php foreach statement
™ forek php foreach with key statement € Restore Removed )
™ function php function statement > o
™ if php if statement
™ inst php instanceof statement L Revertto Default)
™ itdir php iterates a directory
™ iter php iterates an array I( Import... )
M lambda php lambda function statement (closure)
™ my fa php mysql_fetch_array() loop | \
» . Export... ,

™ my_fo php mysql_fetch_object( loop \
M my_fr php mysql_fetch_row() loop L
™ my_gc Trap code output 3

namespace statement Iy

Preview:

Click “Import...” and identify the downloaded “Drupal.xml!” file to add Drupal hook templates.

( Restore Defaults ) (  Apply )

@

( Cancel ) (mON—

z

Preferences > PHP > Editor > Templates
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e

1
QD 2

<?php

1l
2=
3
4
5o
6
7
&
9
10
1t
12
13

Vi,

}

hook_filter

<?php

»

@ *drupal_eclipse_demo.module 23\ drupal_eclipse_demo.info 1

=] hook_filter - Drupal 6 hook filter - Define cont
E hook_filter_format_disable - Drupal 7 hook filt
=] hook_filter_format_insert - Drupal 7 hook filte
=] hook_filter_format_update - Drupal 7 hook filt

= hook_filter_info_alter - Drupal 7 hook filter in
E hook_filter_tips - Drupal 6 hook filter tips - Pr

— y<I>]

hook_filter_info - Drupal 7 hook filter info - Define content filters.

/**

* Implements hook_filter_info().

*/

function module_name_filter_info() {
CL VN bhnwma~CrL1Y array(

= ("),

‘déSéription'
'process callback' => 8
'tips callback' => "',

)3

return $filters;

}

& P?és?‘*‘i ace’ to -s’how"réhail_ét"e 'P}ciicTs Y/

drupal_eclipse_demo.info ]

* Implements hook_filter_info().
"/
function module_namel filter_info() {

$filters[''] = array(

)3

"title' => t(''),

'description' => t(''),
'process callback'
'"tips callback' => A

=> ||’

return $filters;
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Creating (or customizing) your own templates

Thursday, March 8, 2012



Preferences
type filter text Templates i Ea
»Ceneral
» Ant Create, edit or remove templates:
» Aptana Studio ‘Name Context Description Auto Ins ( New )
» Dynamic Languages v s pnp class statement s
» Help @ eco php echo a string [) .
» Install /1 1ndata W elif php ‘elseif statement | ( Edit... )
rlava 8 O O Edit Template
> JavaSc ' :)
»Mylyn Name: hook_action_info_alter Context: _ php ‘%1 ™ Automatically insert
¥ PHP 5
Ap Description: Drupal 7 hook action info alter - Alter the actions declared by another module. !_/
:g: Pattern: Jr* B
* Implements hook_action_info_alter(). -
VEd *
function S{module_name}_action_info_alter(&S Sactions) { :)
$Sactions['${cursor}'];
| D
| ( Insert Variable... )
N Look at an existing function template
2 B
» PH
PH @ ( Cancel ) 670!(‘3
PH W
PHP Manua
PHP Servers }
» Plug-in Development
» PyDev
»Run/Debug
»Team
»Web
» XML ( Restore Defaults ) (  Apply )

@ ( Cancel ) ( OK )

Vz
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66 Preferences

function B{module_namef]action_info_alter(&8Skctions) {
[Shronslfeurson
}

g type filter text b Templates - vy w
b Ceneral j
» Ant Create, edit or remove templates:
» Aptana Studio ‘Name Context Description Auto Ins ( New... )
» Dynamic Languages ¥v] CIs pnp C1ass statement =
» Help V' eco php echo a string O -
P Install /Lindata M elif php elseif statement M ( Edit... )
Pjava (890 L9 Edit Template
b JavaSc : -
»Mylyn Name: hook_action_info_alter Context: ™ Automatically insert
Ap Description: [Drupal 7 hook action info alter - Alter the actions declared by another module. :
: Pattern: ’
N * Implements hook_action_info_alter().
VEd *

r ervarmne) LOOK at the pattern...

Ne
Pa

>: @ ( Cancel ) o)
:HP nua $Sactions['${cu
PHP Servers } 1)

)

V/

Dollar signs get doubled
» Plug-in Development , .
» PyDev 2) Variable parts get wrapped in ${...}

»Run/Debug . '
b Team 3) ${cursor} is where the cursor is placed

> XML

»Web | L
after variable replaceme&;Estore pefauis ) ( Apoly )

@ ( Cancel ) ( OK

)

~
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http://drupalcontrib.org/api/drupal/contributions!views!docs!views.api.php/group/views_hooks/7
http://drupalcontrib.org/api/drupal/contributions!views!docs!views.api.php/group/views_hooks/7

Home » API reference » Drupal 7 » views.api.php

hook views form_submit

6 docs.php hook_views_form_submit($form, &$form_state)

7 views.api.php hook_views_form_submit($form, &S$form_state)

Views form (View with form elements) submit handler. Called for all steps ($form_state['step'])

of the multistep form. .
Get code for a contrib API hook:
Example uses a D7 Views hook

Hooks that can be implemented by other modules in order to implement the Views API.

Related topics

Views' hooks

6 functions implement hook_views_form_submit()
File

contributions/views/docs/views.api.php, line 593

This file contains no working PHP code; it exists to provide additional documentation for
doxygen as well as to document hooks in the standard Drupal manner.

Code

<?php
function hook_views_form_submit($form, &Sform_state) {
// example code here

}

7>

http://drupalcontrib.org/api/drupal/contributions!views!
docs!views.api.php/group/views hooks/7
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http://drupalcontrib.org/api/drupal/contributions!views!docs!views.api.php/group/views_hooks/7
http://drupalcontrib.org/api/drupal/contributions!views!docs!views.api.php/group/views_hooks/7
http://drupalcontrib.org/api/drupal/contributions!views!docs!views.api.php/group/views_hooks/7
http://drupalcontrib.org/api/drupal/contributions!views!docs!views.api.php/group/views_hooks/7

OO

Preferences

. type filter text

» Ceneral

> Ant

» Aptana Studio

» Dynamic Languages
> Help

P Install/lindata

b Java

> Java
b Myly
VPHP

Name:

Description: I_Drupal 7 Views -:Views hook_views_form_submit - form (View with form elements) submit handle

»C
>
VEd

Pattern:

@
PHP

PHP Servers
» Plug-in Development
b PyDev
»Run/Debug
> Team
»Web
> XML

Templates

Name
@ hook_validate php

V' hook_verif... php
Il hanl rdiasas nhn

‘hook_views form submit
. wn Te mn A mm 3K mm wm sl

Create, edit or remove templates:

Context

Description

Drupal 7 hook valid...
Drupal 7 hook verif...

Nranal 7 hanls viaws

Auto Ins¢
on -~
on

Catal - i

Automatically insert !

function hook_views_form_submit(iform. &iform_state) {

"] "example code here

} = e

( Insert Variable... )

0 Template has incomplete variables. Type '$$' to enter the dollar character.

Copy and paste...

template.

( Cancel )

OK

| /.
You may also want to add a docs block to the

(Restore Defaults) ( Apply )

@

( Cancel

) (

OK

)

4
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http://drupalcontrib.org/api/drupal/contributions!views!docs!views.api.php/group/views_hooks/7
http://drupalcontrib.org/api/drupal/contributions!views!docs!views.api.php/group/views_hooks/7

» Plug-in Development
» PyDev

» Run/Debug

> Team

»Web

> XML

OO0 Preferences
" type filter text Templates ¥ e
» Ceneral :
» Ant Create, edit or remove templates:
» Aptana Studio jName Context Description Auto ins C New... )
» Dynamic Languages V' hook_user_... php Drupal 7 hook user ... on
> Help V' hook_user_... php Drupal 7 hook user ... on ( Edit
b install/lindara AL sl cirne  mlne Pt T aal irne am b L sas .
Pjava (€90 2 ED Edit Template
> Jav. i SR P
2 Name: hook_views_form_submit Context: [ php Q 8 Automatically insert |
VPHP A
Description: Drupal 7 Views - Views hook_views_form_submit - form (View with form elements) submit handle |
»C ’
voe Pattern: function ${module_name}_views_form_submit($$form, &$$form_state){ |
vEd ${cursor} {
?
Fix variables, etc... 3
4 (Insert Variable... ) :
Ne
>
; @ ( Cancel ) EoonOieess)
..'.'.' Uatl
PHP Servers

( Restore Defaults ) (  Apply )

( Cancet ) (

OK

)

2
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Productive workflow

Keyboard shortcuts you’ll want to take home with you.

Note: The print version of the presentation does not illustrate all shortcuts
discussed. Most of these were demonstrated with recorded video “clips”.
Some of these have been changed to still graphics for the PDF.
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Keyboard Shortcuts for better workflow

Q

@

5K (Ctrl + K) Next (Add shift key for “Previous” (e.g. to move between

function calls in an open editor window)

® F3 Goto function declaration (in new editor tab if declaration is in another file)

5D (Ctrl + D) Delete current line or selection

50 (Ctrl + O) Lookup function in document (popup menu with all functions

in the current document)

Q

@

8 + Option + 4 (Ctrl + Alt + {)

Duplicate current line or selection (below; use T to duplicate above)

e Option + { (Alt + {) Move selected lines down (use T to move them up)

Q

L.

8/ (Ctrl + /) Toggle commenting (add or remove line comments in PHP code)

e control + M (Ctrl + M) Toggle maximize/restore state of active view or
editor

Thursday, March 8, 2012



7| admin_menu.api.php l 7| admin_menu.module i [P] *intlinks.module £3 °

102 include_once 'intlinks_title_filter.inc';

103 return preg_replace_callback('%<a([A>]*7href="([A"]47)"[A>]*7)>%1",

104 "_intlinks_title_process_link", $text);

105 }

106

107 = /**

108 * Filter process callback for intlinks_hide_bad_filter.

199 *

119 * @param $text

1 B by DA . Text to be filtered. Regex pattern matches links to be processed.

112 *

113 * @return

114 | * Filtered text with proc v
115 | * removed, leaving just & S —

116 | * If all is well, simply @ intlinks_help(Spath, Sarg)

117 *  staff to link unpublish @ intlinks_filter_info()

118 * article is published. © intlinks_title_filter_process(Text)

i e _ @ intlinks_hide_bad_filter_process(Text)

Lo function ‘"thn'f?—h“,’e—bad-_f o intlinks_title_filter_tips(Sfilter, $format, Slong=FALSE)
lhl laclude_once “intlinks ey © intlinks_hide_bad_filter_tips(Sfilter, Sformat, Slong=FALS
122 return preg_replace_callba

123 "_intlinks_process_bad_1

124 [}

125

126= /**

127 * Filter tips callback for

128 x/

129~ function intlinks_title_fil#

130 if (3filter->settings['int

131 return t('Adds node titl

132 ' (as HTML "title" aott] & ) <i»
133 } Press 30" to show in?ér:tec’ membesg
134 } -—

AP 360 (Ctrl + O) Look up function in document

137 * Filter tips callback for intlinks_hide_bad filter.

13% x/

139= function intlinks_hide_bad_filter_tips($filter, $format, $long = FALSE) {
149 if ($filter->settings['intlinks_hide_bad_display_tip']) {

141 return t('Strips broken/unpublished internal links from output.');
142 | ¥

143 }

144
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|30 Q- | B ™| o 1]

v i

m& e HEcie

1EE3I N

i drupal_eclipse_demo
¥ (5 > intlinks [intlinks 7.x-1.2)

> (B git

¥ [F} > intlinks_common_functions.inc
@ intlinks_is_node_path(A)

¥ [P} > intlinks_hide_bad_links.inc
@ _intlinks_process_bad_link(Parameter)
@ intlinks_is_published(The)
@ intlinks_is_special_path(Spath)

v [P} > intlinks_title_filter.inc

ntlinks_title_process_link(Parameter

@ intlinks_get_node_title_from_nid(The)
[} > intlinks.info
¥ [F} > intlinks.module
@ intlinks_filter_info()
@ intlinks_help($path, Sarg)
@ intlinks_hide_bad_filter_process(Text)
@ intlinks_hide_bad_filter_tips(Sfilter, Sformat, Slong=FALSE)
@ intlinks_title_filter_process(Text)
@ intlinks_title_filter_tips(Sfilter, $format, Slong=FALSE)
[} README.txt
= PHP Include Path
b =, PHP Language Library

§ 7 7 -
(@ intlinks_title_filter | [#] intlinks.module l@ intlinks_hide_bad_lin | [#] intlinks_title_filter 53 .
57 '
58 * @return
59 ¢ Original link, possibly modified to include HTML title="value" attribute
60 * and/or URL path alias if link passed was, e.g. <a href="/node/123">.
bl o 4
62 function _intlinks_title_process_link($matches) {
63 if (($matches[2][0] !'= "/") && ($matches[2][0] !'= '.")) {
b4 // Do nothing 1f the link 1s not internal (root rel or doc rel).
65 return $matches[@];
66 // All links *should* be root relative.
67 | 3
68 $has_query = FALSE;
69 $trimmed_path = ltrim($matches[2], "/");
70 if (strpos($trimmed_path, '?')) {
71 $has_query = TRUE;
72 $path_parts « explode('?', $trimmed_path);
73 }
74 else {
75 $path_parts = explode('#', $trimmed_path);
76 }
77 // If an HTML title attribute already exists...
78 if (strpos($matches[1], "title=') !== FALSE) {
79 // and 1f the link 1s not to a "normal Drupal path" (path alias exists)...
80 if (strpos(Smatches[2], '/node/') != @) {
81 // Do nothing if we already have a path alias and title.
82 return $matches[0];
83 }
84 // Deal with links to normal Drupal paths which already have a title.
85 // Change the Drupal path to a path alias, i1f one exists.
86 elseif ($matches[2][0] == '/') {
87 // The 2nd part of a normal Drupal path is the node 1id.
88 if ($node_id = intlinks_is_node_path($path_parts[0])) {
89 $node_path = 'node/' . $node_id;
90 // Get alias, 1f one exists; otherwise, keep path as-is.
91 $path = drupal_get_path_alias($node_path);
92 $insert_path « '/' . check_plain($path);
93 // Exploding around '#' produces 2-element array for paths w/ anchors.
94 if (count($path_parts) == 2) {
95 if (!S$has_query) {
96 // Spath_parts[1l] is the anchor.
97 $insert_path .« '#' . $path_parts[1];
98 }
else {

Note: You can also see all funct

ions by expandlng files in the PHP Explorer perspective

(available in PDT, only) or see the “outline” view in various perspectives.
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3/ (Ctl" + /) Toggle line comments on and off for selected lines.

125
126 /**
127 * Filter tips callback for intlinks_title filter.

128 */
129 // function intlinks_title_filter_tips($filter, $format, $long = FALSE) {

130 // 1f ($3filter->settings['intlinks_title_display_tip']) {

131 B return t('Adds node titles to internal links found in content'
132 Z/ ' (as HTML "title" attribute).');

133 B

134 //

135
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800

Preferences

type filter text

¥V General
» Appearance
Capabilities
Compare/Patch
Content Types
» Editors
Keys
» Network Connections
Perspectives
Search
»Security
» Startup and Shutdown
Web Browser
»Workspace
»Ant
» Aptana Studio
»Dynamic Languages

Keys

Scheme: | Default

+1_— Filter commands to find what you are looking for.

move

Command
Move - Refactoring
Move - Refactoring
Move - Refactoring
Move - Refactoring
Move - Refactoring
Move - Refactoring
Move Lines Down
Move Lines Up
Move Resources

»Help
»Install/Update
> Java

» JavaScript

» Mylyn

Move Type to New File
Move...

Remove All Breakpoints
Remove Block Comment
Remove Block Comment

» PHP

»Plug-in Development
» PyDev

»Run/Debug

»Team

»Web

» XML

Remove Block Comment

e e——

4 Binding
XV
v
3KV
N3EV
3KV
3KV

8.

{36\
{r3e\

When

DLTK View

Editing PHP source
DLTK View

Editing PHP source
In Windows
JavaScript View
Editing Text
Editing Text

Editing in Structured ...

( Copy Command ) ( Unbind Command ) ( Restore Command )

Name:

Move Lines Down

Category User

Refactor - PHP T

Refactor - PHP
Refactor - PHP
Refactor - PHP
Refactor - Java
Refactor - JavaScript

Text Editing
Text Editing

Refactoring
Refactor - Java
File
Run/Debug
Script Source

Edit A

Source

e Modify keyboard shortcut, if you like.

Description: Moves the selected lines down Conflicts:
‘Command When
Binding: il B
When: _ Editing Text W & =) <>
( Filers... ) ( ExportCSV... )

references > General > Keys
Note: 38-shift-L displays list menu of available keyboard shortcuts. (Restoredefauits ) (asply )

R@oeating this keystroke pops up the illustrated “Keys” preferences.

( Cancel ) (oK

/4
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Sack to Plugins...

Ahtik - Eclipse Word Wrap

Note: This plugin is only for the PDT editor, the Aptana Studio 3
editor already includes a Word Wrap function. If you have both PDT
and Aptana Studio 3 installed, you will see two different Word Wrap
options in the contextual menu, even though only one of them is
applicable to the editor you are currently using.
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M%

Available Software | J
Check the items that you wish to install, \‘5)‘_4
Work with:  Ahtik - http://ahtik.com/eclipse-update 3 ( Add... )

Find more software by working with the "Available Software Sites" preferences.

[ type filter text

Name Version
g W (00 Word Wrap
4 {*=Word Wrap Feature 0.0.5

Ahtik - Eclipse Word Wrap Feature

( selectAll ) ( Deselect All ) 1 item selected

' Details
8 Show only the latest versions of available software (] Hide items that are already installed

8 Croup items by category What is already installed?

() Show only software applicable to target environment

g Contact all update sites during install to find required software

@ _ <Back E—Next-’—-) ( Cancel ) _ Finish

Name: Ahtik
Location: http://ahtik.com.eclipse-update
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v .
\ tagir

It @30 | B8e® o [H]Q- &5 & 5 O <Apamae..
T % Jlog l = E\* =
=3 s &
55 484 $elements[$path]['#children'] = theme('ad " lements[$path], 'depth' => $de ]
T: 485 if (lempty($elements[$path]['#children']) : Undo.Text Change Z

486 $elements[$path]['#attributes']['class' Revert File :

487 } _ =] Save %S

488 if (isset($elements[$path]['#attributes'] =

489 $elements[$path]['#attributes']["'class’ Com ds > iss']; El

499 }

491 .

< 80-Character markerse. w .

493 $link = ''; Show In >

494 if (isset($elements[$path]['#href'1)) { Open PHP Manual {+F2

495 // Strip destination query string from hn Open Declaration F3

496 // for our JavaScript behavior instead. Qui k Outli €0

497 if (isset($elements[$path]['#options']['qg uic u '"? th]['#options']['query']['dest

498 unset($elements[$path]['#options']1['que Open Type Hierarchy F4

499 $elements[$path]['#options']['attribute Qui(k Type Hierar(hy ®T §:

zgi’ } Open Call Hierarchy C%H

592 $link .= 1(Selements[$path]['#title'], Se ¥ Search V][ '#options']); =)

503 }

504 elseif (isset($elements[$path]['#title']))  Cut ~ X

505 if (!empty(Selements[$path]['#options'][* Copy ¥C

506 $title = $elements[$path]['#title']; Paste A\

507 } -

508 else {

509 $title = check_plain($elements[$path][" 32 Deploy > =

519 } % 2

511 if (lempty(Selements[$path]['#options']J[" Quick Fix #1 =

512 $link .= '<span' . drupal_attributes($e Source P D . '>" . $title . "</span>';

513 }

514 else { = Properties

515 $link .= $title;

516 . } Word Wrap

517

Run As > m
518 Nabeis A |

Word wrap (OFF)
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D '-_ ‘nayv sta 'ﬂ-..',.--

— _— e

J L Y [ <AptanaWe... »

- W - el = iay j 1 LSS Sl Iy 1Ico/al
| 8~ %0 | Ec® 9| 4
i

) [ E-‘- —=
5 - s . s g ][ 3 EU]_])) 1 ﬁ—‘ 5

482 elements[$path]['#sorted'] = TRUE; M
S 483 } B
f: 484 $elements[$path]['#children'] = theme(‘adhin_menu_links', array('elements’ —

485 => $elements[$path], 'depth' => $depth_child)); =

486 if (lempty($elements[$path]['#children'])) { 0=

487 $elements[$path]['#attributes']['class'][] = 'expandable'; Q=

488 }

489 if (isset($elements[$path]['#attributes']['class'])) {

490 $elements[$path]['#attributes']['class'] = $elements[$path]['#attributes']

491 ['class'];

492 }

493 }

194 80-Character marker —M8M@M@8@8™ >

495 $link = '"';

496 if (isset($elements[$path]['#href'])) {

497 // Strip destination query string from href attribute and apply a CSS class

498 // for our JavaScript behavior instead.

499 if (isset($elements[$path]['#options']['query']['destination']) && $elemerts

500 [$path]['#options']['query']['destination'] == $destination) {

501 unset($elements[$path]['#options']['query']['destination']); —

502 $elements[$path]['#options']['attributes']['class'][] = 'admin-menu-

503 destination’';

504 }

505

506 $link .= L($elements[$path]['#title'], $elements[$path]['#href'], $elements =

507 [$path]['#options']);

508 } =)

509 elseif (isset($elements[$path]['#title'])) {

519 if (lempty($elements[$path]['#options'J['html'])) { —

511 $title = $elements[$path]['#title'];

512 }

513 else {

514 $title = check_plain($elements[$path]['#title']);

Word wrap (ON)
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423

}

484
485

$elements[$path]['#children'] = theme('
if (lempty($elements[$path]['#children'

486
487
488
489
490
491
492
493
494
495
496
497
498
499
509
501
592
503
504
595
506
507
508
509
519

$elements[$path]['#attributes']['clas
}
if (isset(%elements[$path]['#attributes
$elements[$path]['#attributes']['clas
}
}

$link = '';
if (isset($elements[$path]['#href'])) {
// Strip destination query string from
// for our JavaScript behavior instead.
if (isset($elements[$path]['#options']|
unset($elements[$path]['#options']['c
$elements[$path]['#options']['attribe
}

$link .= 1(%elements[$path]['#title'],
}
elseif (isset($elements[$path]['#title']]
if (lempty($elements[$path]['#options']
$title = $elements[$path]['#title'];
}
else {
$title = check_plain($elements[$path]
}

Word wrap (OFF)

Selements[$path]['#children'] = theme(‘adbin_menu-links'. array('elements’
elements[$path], 'depth' => $depth_child));
if (lempty(Selements[$path]['#children'])) {
$elements[$path]['#attributes']['class'][] = 'expandable’;
}

if (isset(3elements[$path]['#attributes']['class'])) {
$elements[$path]['#attributes']['class'] = $elements[$path]['#attributes']
['‘class'];
}
}

$link = "%
if (isset(3elements[$path]['#href'])) {
// Strip destination query string from href attribute and apply a CSS clasds
// for our JavaScript behavior instead.
if (isset($elements[$path]['#options']['query']['destination']) && $elements
[$path]['#options']['query']['destination'] == $destination) {
unset($elements[$path]['#options']['query']['destination']);
$elements[$path]['#options']['attributes']['class'][] = 'admin-menu-
destination’';

}

$link .= 1(Selements[$path]['#title'], Selements[$path]['#href'], $Selements
[$path]['#options']);
}
elseif (isset(Selements[$path]['#title'])) {
if (lempty(Selements[$path]['#options']J["html'])) {

€3 bla o CalamantelltnathWITN 4eskl1a'.

Word wrap (ON)

Note: Line numbers not accurate with word wrap on

(Turn word wrap back off to see correct line numbers.)
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admin_menu.module — admin_menu

—
* admin_menu.module —‘L_! adrmfin;merhﬁdr
$depth_child = $depth + 1; » [ Jadmin_devel
465 foreach (element_children(Selements, TRUE) as $path) { = admin_menu-rtl.css
// Early-return nothing if user does not have access. e admin_menu.api.php
if (isset($elements[$path]['#access']) && !Selements[$path]['#access']) { %lad"ﬂ"-mQ““£°k”£55
468 continue; £ admin_menu.css
460 } = admin_menu.inc
700 Selementslipatr] 4= arra
ﬂfA gattvlbutes => array(), B S enin
7 ‘#options® => array(), = admin_menu.map.inc
)3 i admin_menu.module
47 /7 Render children to determine whether this link 1s expandable. = admin_menu.uidl.css
475 if (isset($elements[$path]['#type']) || isset(Selements[Spath]['#theme'])) { » | ladmin_menu_toolbar
$7¢ Selements[Spath]['#admin_menu_depth'] = S$depth_child; » | ladmin_views
Selements[Spath]['#children'] = drupal_render(S$elements[$path]); = CHANGELOG.txt
} __limages
$79 else { = LICENSE.txt
480 /7 Inherit #sorted flag from parent item. — README.txt
‘ if (isset(Selements['#sorted'])) { > Ltests
$elements[Spath]['#sorted'] = TRUE; [ translations

}

- Selements[Spath]['#children'] = theme('admin_menu_links', array('elements' =>
Selements[Spath], 'depth' => $depth_child));

RS if (lempty(Selements[$path]['#children'])) {
486 $elements[$path]["#attributes']['class'][] = 'expandable’;
87 }
488 if (isset(Selements[Spath]['#attributes']['class'])) {
48! $elements[$path] ['#attributes']['class'] =
Selements[Spath]['#attributes']['class'];

} n
3 Comparison: Textmate with “Soft wrap” feature on.

$link = ''; D
if (isset($elements[$path]['#href'])) {
// Strip destination query string from href attribute and apply a (55 class
// for our JavaScript behavior instead.
if (isset(Selements[Spath]['#options']['query']['destination']) &&
Selements[Spath]['#options']['query']['destination'] == Sdestination) {
498 unset($elements[$path]['#options']['query']['destination']);
49! $Selements[$path]['#options']['attributes']['class'][] = 'admin-menu-destination’;

.44

SO }

200 Al
=

A1

ar!

Line: 484 Column.: A1 y HTML
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u.module uadmin_menu.js \
$elements[$path]['#sorted'] = THUL;

483 »
484 $elements[$path]['#children'] = theme('admin_menu_links', array('elements'
- $elements[$path], ‘depth' - $depth_child));

485~ if (lempty($elements[$path]['#children'])) {

486 $e1ementk[$path]['#attributes‘]['class‘][] = 'expandable':

487 -

488- if (isset($elements[$path]['#attributes']['class'])) {

489 $elements[$path]['#attributes']['class'] = $elements[$path]
["#attributes']['class’'];

499 .

491

4972

493 $link = '';

494~ if (isset($elements[$path]['#href'])) |

495 // Strip destination query string from href attribute and apply a CSS
class

496 // for our JavaScript behavior instead.

497~ if (isset($elements[$path]['#options']['query']['destination']) &&
$elements[$path]['#options']['query']['destination'] == $destination) |

498 unset($elements[$path]['#options']["query']['destination']);

499 $elements[$path]["#options']['attributes']['class'][] = 'admin-menu-
destination’;

500 |

Note: With Aptana Studio 3 Eclipse plugin (at least when using Studio
3’s “PHP Source” editor), soft-wrapped lines are correctly renumbered if
you drag a view wider or narrower (as illustrated — Aptana Studio info
later).
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Sack to Plugins...

Eclipse Color Theme
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®No Install

Available Software ﬁl
Check the items that you wish to install. { —J.
v 03
L = =
Work with: [Ecllpse Color Theme - http://eclipse-color-theme.github.com/update 3 ( Add... )

Find more software by working with the "Available Software Sites" preferences.

 type filter text

‘Name Version
@ ¥ (00 Eclipse Color Theme
4] Y+ Eclipse Color Theme 0.11.1.201106241814

Name: Eclipse Color Theme
Location: http://eclipse-color-theme.github.com/update

( Select All ) (Deselect All ) 1 item selected

Details
8 Show only the latest versions of available software (] Hide items that are already installed
8 Group items by category What is already installed?

(] Show only software applicable to target environment

E Contact all update sites during install to find required software

@ < Back G—NUR!’—’ ( Cancel ) Finish
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http://eclipse-color-theme.github.com/update
http://eclipse-color-theme.github.com/update

S ) Preferences

Color Theme » >
Ceneral
Appearance Theme:
Color Theme Default
Colors and Fonts Black Pastel public class Demo {
Label Dececrations Gedit Original Oblivion private static final String CONSTANT = "String":;
Capabilities Havenjark private Object o;
Comparc/Patch inkpot
Content Types Monokai Jhw
Egitors Mr * Creates a new demo.
nEVE ; NightLion Aptana Theme * @param o The object to demonstrate.
Network Connections Notepad++ Like */
Perspectives Oblivion :
T T public Demo(Object o) {
S Obsidian this.o = o:
Pastel
Startup and Shutdown RecognEyes §tring 8 = CONSTANT;
Web Browser Retta int i = 1;
Workspace Roboticket
Ant Schuss
Aptana Studio Sublime Text 2 public static void main(String[] args) {
Dynamic Languages Sunburst Demo demo = new Demo():
Help Tango
Install/Update Vibrant Ink
java Wombat
JC:VJSCI'I ot Zenburn Created by Ciaran McCreesh
;ﬁ)yn ern.tenddev http: / /www.vim.org/scripts/script.php?script id=1143
minimal
Plug-in Development
PyDev
Run/Debug Download more themes or create your own on eclipsecolorthemes.org.
Team . , ; ,
Web ~Import a theme... _ Restore Defaults :
XML
Apply
(?) ~ Cancel ) (eemGK—-
P nhn- I‘I]T_.fbn' L BAHSCEA p B ST -1 LRl TR L Ty M VT NS K PLr el A ROl s LR B E NIl BT AR C T (Y g B o S - e e e L L L L L |

Preferences > General > Appearance > Color Theme

| don’'t mind the default theme, but maybe you want a different one.
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Another very popular plugin...

Aptana Studio as Eclipse plugin
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Download Aptana Studio 3.0.8

Aptana Studio 3.0.8 is our code base and complete environment that includes extensive capabilities to build
Ruby and Rails, PHP, and Python applications, along with complete HTML, CSS and JavaScript editing.

You are about to download: System Requirements

Aptana StUdIO 308 Eclipse 3.5 or better

Mac OS X, Intel

Standalone Version Eclipse Plug-in Version

Please provide us your name and email address so that we can get a better sense for who uses our product. We may use
this email to occasionally communicate product and company news.

Name Email Address

Lowell Montgomery lowellmantaomerx@gmail.com

DOWNLOAD

APTANA STUDIO 3

vl -

http://www.aptana.com/products/studio3/download
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http://www.aptana.com/products/studio3/download

Eclipse Plug-in Installation

Installing via Eclipse

Please copy the following Update Site URL to your clipboard and then follow the steps listed below to add this URL
to your Available Software Sites list. Attempting to access this URL using your web browser will return an Access
Denied error.

http://download.aptana.com/studio3/plugin/install

1. From the Help menu, select Install New Software... to open the Install New Software dialog.
2. Paste the URL for the update site into the Work With text box, and hit the Enter (or Return) key.
3. In the populated table below, check the box next to the name of the plug-in, and then click the Next button.
4. Click the Next button to go to the license page.
5. Choose the option to accept the terms of the license agreement, and click the Finish button.
6. You may need to restart Eclipse to continue.
Welcome!

If you are reading this, we'd like to thank you for your interest Aptana Studio.
Please read through this guide carefully.

For Aptana Studio 2 Upgraders

Aptana Studio 3 is intended to be completely independent from Aptana Studio 2.
You can install both Studio 2 and Studio 3 separately and run them both on the
same machine, since they will use different workspace directories. If you wish to
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Available Software

Check the items that you wish to install.

Work with: IAptana Studio - http://download.aptana.com/tools/studio/plugin/install/studio ﬂ C Add... )

Find more software by working with the "Available Software Sites" preferences.

48 Y e,

| type filter text

Name Version

8 v 000 Aptana Studio

8 %&Aptana Studio 2.0.5.1278522500-5-7857H)97CFF61HN...

(" selectAll ) ( Deselect All ) 1 item selected

' Details :

8 Show only the latest versions of available software (] Hide items that are already installed

™ Group items by category What is already installed?

(] Show only software applicable to target environment

8 Contact all update sites c_iuring install to find required software
Aptana Studio 2:
http://download.aptana.com/tools/studio/plugin/install/studio
@ (< Back ) W ( Cancel ) C  Finish )

V
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http://download.aptana.com/tools/studio/plugin/install/studio

Available Software

Check the items that you wish to install.

Work with: :Aptana Studio 3 - http://download.aptana.com/studio3/plugin/install B ( Add... )

Find more software by working with the "Available Software Sites” preferences.

4 X N

. type filter text

Name Version

8 L@?:Aptana Studio 3 Plugin 3.0.8.201201201626-7E37L7HFGQGNJXI...

( selectAll ) ( DeselectAll ) 1 item selected

' Details |

g Show only the latest versions of available software (] Hide items that are already installed

8 Group items by category What is already installed?

[} Show only software applicable to target environment

g Contact all update sites during install to find required software
Aptana Studio 3:
http://download.aptana.com/tools/studio3/plugin/install

@ (< Back / e—"N!xt"——a ( Cancel ) " Finish
Vi
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SO Preferences

type filter text PHP Pv vy w
» Ceneral
» Ant W Preferences for the PHP Editor
¥ Aptana Studio Mark Occurrences
v(E::.rtltent Assist } [ ] Mark occurrences with background color
itors
CSsS .
ERB Indentation
HAML Tab policy: | Al T ize:
: ab size:
HTML _ Use Spaces ' va 2
JavaScript | W Auto-indent new line on carriage return
JSON
‘_1 Folding
Libraries
Ruby } ™ Enable folding
SASS .
XML Initially fold these elements:
YAML [ Types
Find Bar ~
] Functions
Formatter
» JavaScript Debug | PHPDoc
=
Remgte [ Multi-line comments
Spelling —
Tasks

Themes. Note: This adds new editor preferences which will

Troubleshooting

Validation need “Tab policy” to be modified for spaces/2

»Web Servers
» Dynamic Languages
> Help A
» Install/Update 3 (_Restore Defaults ) (_ Apply )
L TN

@ ( Cancel ) f OK 3

Preferences > Aptana Studio > Editors > PHP
(and others under Editors)
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Window Help % £
Bundle Development Show Scope ~0p |

v

’ Capistranp > Copy Scope ~03C
i g:;feeScnpt : Show Scope and Matching Theme Rule 3P
}' Cucumber S Show ENV ~OE
Englive’yard € Install Bundle
HAML >
AT > Update User Bundles
HTML »  FlushBundie Caches 1) Gommands > Bundle Development > Install Bundle
JavaScript »  Show Command Bindings !
JSON »  Show Active Commands in Scope
Math »  Show Active Snippets in Scope j
PHP b ;
Rails b Insert Bundle Section b
zs;t:;ec : Validate Snippets
i Convert TextMate Bundle
Sass I
Shell Script > Edit this bundle
Source P W& TIGITUITK U E Project; Serect rroperues
Text > . ,
XML > ks If you already have the jQuery bundle:
YAML P 1. Choose Commands > Bundle Developme

Boxee Boxee
Bundler Bundler
Drupal : IhpliEEs—————eeaa s |
GitHub 2) Select jQuery “Bundie” GitHub
(1 7
Mercurial Mercurial 3) Repeat Step 1 and
Play Framework Play Framework
RSense RSense select Drupal Bundle.
Scaffold Scaffold
Titanium Desktop Titanium Desktop
Titanium Mobile Titanium Mobile
WebFont WebFont
Wordpress Wordpress
Zen Coding Zen Coding
@ ( Cancel ) EOK— ® ( Cancel ) —o—9
2 Z
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Where to find the “Rubles” (bundles) in your
fille system:

Mac/Linux: ~/Documents/Aptana Rubles

__| Aptana Rubles

" Y . B

< ‘ > oo | = | o It ~ Q
Back View Quick Look Action Search

¥ DEVICES ~ [25] Applications o [—:/ About Stacks.pdf (] drupal.ruble l
| Macintosh SSD (=] Desktop l || Aptana Rubles 3 " (] javascript-jquery.ruble |
=4 Macintosh HD (0] Documents » | (] Biologis Files » [ php.ruble |
= MacHD_TimeMachine | (3] Downloads (] Burn Temporary , (] wordpress.ruble l
=4 Randi iTunes Sync [j dwhelper l__[ Bus_from_...ter_car.pdf

(] eBooks % Bus_from_...er_car2.pdf

|
|
|
» SHARED ] iMacros A Efj Bus_from_...er_car3.pdf
|
|
|
|

. PLACES (] Library '%| Bus_to_register_car.pdf
A Deskrop L@ Movies - l;'fj cheatsheet...g.com.pdf .
AN [_ﬂ Music * 4] Cocomore...st (3).docx A
e e * | (&3] Pictures " | | Cocomore...ebsite Docs ~ °
?&; Applications ] (&1 _Puhlic b I [Y1_raramara _ta Noce zin I

4 items, 28.93 GB available

Windows: Aptana Rubles directory in your user folder.
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2,

"tips cnllharck' -~ 'intlinke hida had filtar +ips

); ~ Undo Text Change $Z
, return 3f  pevert File
= Save 38 S
Bundle Development
oo ; Capistrano
L Open With ¥ CoffeeScript
" Show In
o i’ Open PHP Manual Custom
. Open Declaration aggregator
- Ouick NOutline block
contextual X »  Edit this bundle
dashboard b
field 2
field_ui P
file 2
filter b
help b
A it_view . /iew image b
e e P (ocale >
. ¢ Quick Fix %1 ke g
» fext §  cource p ks to be node 2
: openid P
' 1ten = Properties li ke 1o 4 OVerlay >
L word Wap ey s I
: _f?- Run As P /e links s search >
., 2reicd  Debug As g shortcut =

Taam L

t'ﬁthe time of my DrupalCamp Essen session this had me stumped.

It turned out that the hook and theme function templates found in the Commands menu (provided by Aptana-installed
“bundles”, aka “Rubles”) only work when active in the “PHP Source Editor”, which is provided by the Aptana plugin. Bundle-
added commands are “grayed out” when active in the PDT-supplied “PHP Editor” view, but it’s not easy to tell which editor is
in use. For easiest use of Aptana Studio’s bundles, you may wish to uninstall PDT and the Drupal PDT plugin, then assign
the “PHP Source Editor” to .module, .install, .test, profile, .engine, and .test files.
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DrupalCamp
ESSEN 2012

Drupal development with the Eclipse IDE

Lowell Montgomery, Cocomore AG / Freelancer

2
cocomere’

drupal.cocomore.com/blog

Keep an eye on the Cocomore Drupal Blog ( http://drupal.cocomore.com/blog ) for more tips
to improve productivity in Eclipse / Aptana and for other useful Drupal-related articles.

An article expanding on this presentation has now lbeen posted:
http.//drupal.cocomore.com/blog/using-eclipse-pdt-drupal-development
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